Personal Budget

One of the most useful ways in which you can use Excel in your daily life is to create a budget to keep
track of your income and expenses. You can then use your budget to identify and track trends. For exam-
‘ple, you can determine if you spend a consistent amount each month on entertainment or if you spend
less in some months than in others. You can also use the budget to ask “what-if” questions to identify how
best to allocate your resources. To create the personal budget, you Enter and Enhance Labels,
Calculate Totals, Ask What-If Questions, and Format and Print the Budget. The completed
budget appears in FIGURE 3-10 on page 63.

Enter and Enhance Labels

You create a worksheet, enter and enhance the worksheet title, then add the labels for the months of the
year and the income and expense categories.

1. Start Excel and open a new blank workbook, type Six-Month Budget, press [Enter], type
the labels in cells A2 to A7 as shown in FiGURE 3-1, then save the workbook as PR 3-Six-
Month Budget to the location where you save the files for this book

2. Click cell A1, click the Page Layout tab, click the Themes button in the Themes group,
click Slice, click the Home tab, click the Font Size list arrow [ -] in the Font group,
change the font size to 22 pt, then click the Bold button [B]in the Font group

3. Click cell A2, then change the font size to 14 pt

4. Select cells A1:H2, right-click the selection, click Format Cells, click the Alignment tab,
click the Horizontal list arrow, click Center Across Selection, then click OK

5. Select cells A1:H1, click the Fill Color list arrow |2 -/ in the Font group, click Dark Green,
Accent 4, Darker 25%, click the Font Color list arrow /A - in the Font group, then
click White, Background 1

6. Click cell B3, type JAN, move the pointer over the lower-right corner to show the Fill
Handle pointer 4, drag 4 to cell G3, click the Center button = in the Alignment
group, click cell H3, then type Totals and press [Enter]

The labels for the months from January to June are added and centered.

7. Click B on the worksheet frame, click and drag to select columns B to H as shown in
FIGURE 3-2, click the Format button in the Cells group, click Column Width, type 14, then
click OK

8. Click cell A9, then enter the labels required for cells A9:A25 as shown in FIGURE 3-3

9. Click the Review tab, click the Spelling button in the Proofing group, click Yes if
prompted, correct any spelling errors, then save the workbook
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FIGURE 3-1: Labels for Cells A1 to A7
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FIGURE 3-2: Selecting columns
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FIGURE 3-3: Labels for Cells A9 to A25
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Merging cells

A merged cell is created by combining two or more cells into in the Alignment group on the Home tab and then adjust the
a single cell. The cell reference for the merged cell is the alignment as needed. If you want to center data across several
upper-left cell of the originally selected range. When you consecutive rows, use the Alignment tab in the Format Cells
merge a range of cells containing data, only the data in the dialog box and select Center Across Selection. The data is
upper-left cell of the range is included in the merged cell. To centered across several cells but the cells themselves remain
merge cells in a single row, use the Merge and Center button separate and are not merged.
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Excel 2016
Module 3

Personal Budget (continued)

. Calculate Totals

You need to enter the income and expenses for the first six months of the year. Then, you need to
calculate self-employment income, total income, and expenses.

You use a new
worksheet to avoid
cluttering the first
worksheet with
data that will not
be printed.

If your computer

supports the use of
function keys, press
[F4] or [Fn][F4] to
insert the dollar
signs in the selected

cell reference.

Double-click the column divider between columns A and B on the worksheet frame to
increase the width of column A to fit all the labels, click cell B10, enter the values for
January as shown in FIGURE 3-4, select cells B10:B22, position the pointer over the
lower-right corner of cell B22, then drag = to cell G22

Double-click the Sheet1 tab at the bottom of the worksheet, type Budget, press [Enter],
click ®), double-click the new sheet tab, type Other Income, then press [Enter]
In addition to your salary, you have earned income from website design work and garden work.

. Type Hours in cell A1, press [Enter], select cells A1:G1, click the Home tab, click the

Merge & Center button in the Alignment group, fill the merged cell with Dark Green,
Accent 4, Lighter 80%, click the Bold button B, click cell B2, type January, fill the
range C2:G2 with the remaining months, then bold and center the labels

Using FIGURE 3-5 as a guide, enter and format the labels and values in cells A3 to G11,
widening column A as needed
Your worksheet should look like FIGURE 3-5.

Click cell B6, enter the formula =B3*B10, press [Enter], then copy the formula through
cells C6:G6

Oops! Cells C6 through G6 contain no values. Why? When you copied the formula, Excel changed the cell
references in the copied formula because the formulas contained relative references. You need to enter a
formula in cell B6 that uses an absolute reference for cell B10 (the rate of pay for web work). When you use
an absolute cell reference, the value associated with the absolute cell reference remains constant no matter
where the formula is copied to in the worksheet.

. Click cell B6, select B10 in the formula bar, type $B$10, press [Enter], click cell B6

again, then drag = to fill cells C6:G6 with the revised formula
Click cell B7, enter the formula =B4*$BS$11, copy the formula through cells C7:G7,
select the range B6:G8, then click the AutoSum button in the Editing group

In January and February, $ - is displayed in cells B7 and C7 because no hours were worked during
those months.

. Click the Budget tab, click cell B6, type =, click the Other Income tab, click cell B8,

press [Enter], then drag = in cell B6 to fill the range C6:G6

Click cell BS, type 2650, use the fill handle to copy the value to the range C5:G5, select
the range B5:H7, click the AutoSum button in the Editing group, select the range
B10:H23, click the AutoSum button, then save the workbook

The total income displayed in cell H7 is 19025 and the total expenses shown in cell H23 are 16950, as
shown in FIGURE 3-6 (shown in 80% zoom).
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FIGURE 3-4: Values for cells B10 to B22
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10 [Housing 1100
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5 12 {Car Payment 200
13 |{Car Insurance 100
14 {Gas 100
1= fHome Phone i Values for January
16 |Cell Phone 7§ A
17 {Cable and internet 100 expenses
18 |Sundiries 50
19 |Utilities 50
20 |Entertainment 100
21 [Student Loan 200
22 |Savings 300
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FIGURE 3-5: Labels and values for the Other Income sheet
4] A B SR e e S T G H
1] Hours
2 | January February March April May June
3 |Web 10 10 20 10 10 5
{ '
4 |Garden 0 0 10 20 20 25
5| Total Pay
6 |Web
7 Garden
8 Total Pay
9
10 WebRate  $ 25.00
11 |Garden Rate $ 20.00
12
)
13]
FIGURE 3-6: Worksheet completed with totals
A B C ! D i E F G i H aobn gise ]
1 Six-Month Budget
2 { July to December 2017
3] JAN FEB MAR APR MAY JUN Totals
4 :lncorre
5 [Salary 2650 2650 2650 2450 2650 2650 15900
é_{Otherincome $ 25000 $ 25000 $ 70000 $ 650.00 $ 65000 $ 62500 $ 312500 Total income
7 |Totalincome 2900 2900 3350 3300 3300 3275 19025 e |
is 19025
d 1100 1100 1100 1100 1100 1100 6600
11 |Food 400 400 400 400 400 400 2400
12 |Car Payment 200 200 200 200 200 200 1200
13 |Car Insurance 100 100 100 100 100 100 600
14 |Gos 100 100 100 100 100 100 400
15 |Home Phone 50 50 50 0 50 50 300
16 |Cell Phone 75 75 75 75 75 75 450
17 |Cable and Internet 100 100 100 100 100 100 400
18 |Sundries 50 50 50 50 50 50 300
19 Jutilii 50 50 50 50 50 50 300
20 [Ent 100 100 100 100 100 100 600
21 |student Loan 200 200 200 200 200 200 1200
22 |Savings 300 300 300 300 300 300 1800 al expense:
23 |Total Expenses 2825 2825 2825 2825 2825 2825 R TOt p S
2] 1 is 16950
25 |Cash Availoble I I o
|_Budget | Other incom | @ L]

Understanding relative and absolute references

By default, Microsoft Excel considers all values entered in
formulas as relative values. That is, Excel automatically changes
all cell addresses in a formula when you copy the formula to a
new location. If you do not want Excel to change the cell
address of a value when you copy it, you must make the value
absolute. To do this, you enter a dollar sign ( § ) before both

the column and the row designation in the address.

For example, $C$26 tells Excel that the reference to cell C26
must not change, even if you copy the formula to a new
location in the worksheet. If your computer supports the use
of Function keys, you can click the cell reference and then
press [F4] or [Fn][F4] to insert the §.
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. Ask What-If Questions

You need to calculate how much cash is available each month, and then perform the calculations required
to answer several what-if questions. You also create sparklines to provide a quick visual review of monthly
variations in income, expenses, and cash flow.

WSewsly  Personal Budget (continued)

1. Click cell B25 on the Budget tab, enter the formula =B7-B23, press [Enter], then copy
the formula across to cell H25
The total cash available at the end of six months, given the current level of income and expenses, is 2075.
The first what-if question is “What if you raise the hourly rate charged for web design work to §50?"

2. Click the Other Income tab, click cell B10, type 50, press [Enter], widen columns if ##
marks appear, then click the Budget tab
By changing the amount charged for web design work, you answer the what-if question and see that your
total profit in cell G23 increases to 3700. Next, you want to know, “What if an increase in the hourly rate
for web design work results in a 40-percent drop in the number of hours worked from January to June?”

3, Click the Other Income tab, click 4 on the worksheet frame to select row 4, click the
Insert button in the Cells group (a new row appears above “Garden”), click cell A4,
type 60%, click cell B4, enter the formula =B3-(B3*$A$4) as shown in FIGURE 3-7,
press [Enter], then copy the formula to the range C4:C4

4. Click cell B7, select B3 in the formula bar, type B4, press [Enter], copy the revised
formula through cells C7:G7, then click the Budget tab

The new total in cell H25 is 1750—quite a reduction from 3700! Perhaps you shouldn't raise the hourly rate
if the result is a 60-percent drop in the number of hours worked.

5. Click the Undo button E2J until the extra row is removed from the Other Income sheet
) and the value in cell B10 is again $25.00 (you will click the Undo button about ten

times), then return to the Budget sheet
The value in cell H25 is again 2075. Next, you want to know, “What if Housing costs increase to
$1,200/month starting in March?"

6. Click cell E10 in the Budget sheet, type 1200, then drag the fill handle to cell G10
If you increase your housing cost, you reduce your total available cash (cell H2S) to 1775. You can experi-
ment endlessly with entering various combinations of values for income and expenses to see the effect on
the “bottom line.”

7. Click cell 13, type Trend, press [Enter], click cell 17, click the Insert tab, click Column in
the Sparklines group, move the Create Sparklines dialog box down as needed so you
can see row 7, select the range B7:G7, then click OK
You insert a Column sparkline to provide a visual representation of the variations in income over the
six months covered by the budget. ‘

8. Click the High Point check box in the Show group, click the Home tab, click the Copy
button in the Clipboard group, click cell 123, click the Paste button, click cell 125, then
click the Paste button

9. Modify values as shown in the highlighted cells in FIGURE 3-8, verify that 1575 appears
in cell H25, then save the workbook
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FIGURE 3-7: Calculating a reduction in hours worked

SUM - X _f p=83-(B3*3A%)

Formula in cell B4 D i E ! F i G H

. 1 Hours

2: January February March April May June
3 |Web 10 10 20 10 10 5
4 60%{=B3-(B3*$ 8 4 4 2
5 |Garden 0 0 10 20 20 25
6 | Total Pay
7 |Web $ 500.00 $500.00 $1,000.00 $500.00 $500.00 $ 250.00
8 |Garden $ - $ - $ 200.00 $400.00 $ 400.00 $ 500.00
9 |Total Pay $ 500.00 $500.00 $1,200.00 $900.00 $500.00 $ 750.00
10/
11 |Web Rate $ 50.00
12 |Garden Rate § 20.00
13

1
2 July to December 2017
|3 j JAN FEB MAR APR MAY JUN Totals Trend
4 |Income
5 |Salary 2650 2650 2450 2650 2450 2650 15900
6 |Other Income $ 25000 $ 25000 $ 70000 $ 65000 $ 65000 $ 62500 ' $ 3,125.00
'T‘qTo‘chncome 2900 2%00 3350 3300 3300 3275 19025 __HEEN
8
9 |Expenses
IQA Housing 1100 1100 6900
17 |Food 2600
12| Car Payment 1200
13 |Car Insurance 400
14| Gas 600
15 |Home Phone 100
16 |Cell Phone 450
17 |Cable and Internet 400
18 |Sundries 300
19 |Utilities 400
20 |Entertainment 400
2] |Student Loan 1200
ZEchings 1900
25To+clExpenses 17450 _W__0_
24
25 |Cash Available 1575 __HEam
i Budget \ / K I
4 \Y N

Utilities expense rises in

January and February

Home phone is canceled
from March to June

Savings are increased
in February

Food expense rises
in March and May
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Excel 2016

Module 3

Personal Budget (continued)

Format and Print the Budget

To make the worksheet easier to read, you need to add border lines and fills to selected cells, format
values using either the Accounting Number Format or the Comma Style (depending on their location in
the worksheet), and then use a variety of Page Setup features.

1. Select cells A3:13 on the Budget tab, click the Border list arrow __ | in the Font group,
click More Borders, then refer to FiGuRE 3-2: click the single thick border in the Style list,
click the Color list arrow, click Dark Green, Accent 4, Darker 25%, click the Top Border
button, click the Bottom border button, click OK, then apply bold

2. Select cells A5:A6, fill them with Dark Green, Accent 4, Lighter 60%, fill the range B5:H6
with Dark Green, Accent 4, Lighter 80%, then format the Expenses cells with Red, Accent 6,
Lighter 60% and Lighter 80% and the Cash Available row with Dark Blue, Text 2, Lighter
60% and Lighter 80%

3. Click cell A4, press and hold the [Ctrl] key, click cells A7, A9, A23, and A25, then apply Bold

You use the [Ctrl] key to select a series of nonadjacent cells.
4. Select the range B5:H25, then click the Comma Style button 3 |in the Number group

5. Select the range B5:HS5, press and hold the [Ctrl] key, select the ranges B7:H7, B10:H10,
B23:H23, and B25:H25, then click the Accounting Number Format button [$]in the
Number group

To complete these
steps, use the com-
pleted budget in
FIGURE 3-10 as
a guide.

6. Select cells A1:11, click the Merge & Center button in the Alignment group, then merge
and center cells A2:12
When you add columns to a worksheet, you sometimes need to adjust how cells are merged so the work-
sheet appears balanced.

7. Click 7 on the worksheet frame, press and hold [Ctrl], select row 23 and row 25, click
the Format button in the Cells group, click Row Height, type 30, click OK, select and fill
cells A8:18 with Dark Green, Accent 4, Darker 25%, repeat for cells A24:124, select row 8
and row 24, then set the row height to 8
With an increased row height, the sparklines are more visible. The narrow rows look like border lines which
gives the worksheet a finished look.

8. Click the File tab, click Print, click Portrait Orientation, click Landscape Orientation, click
the Page Setup link at the bottom of the Print pane, click the Margins tab, click to
select the Horizontally and Vertically check boxes, click the Header/Footer tab, click
Custom Header, type Six-Month Budget in the left section, press [Tab] twice, type your
name in the right section, click OK, then click OK again

MORE PRACTICE 9. Click the No Scaling list arrow, click Fit Sheet on One Page, then compare the completed
For more practice

worksheet to FIGURE 3-10
with the skills

presented in this } 10. Click © to exit Backstage view, save the file and submit it to your instructor, then

project, complete | close the workbook
Independent ‘

Challenge 2. i
SR
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FIGURE 3-9: Format Cells dialog hox

Format Cells ?
Number Alignment Font Fill Protection
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Style:
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Border style selected

Dark Green, Accent 4, ____
Darker 25% selected

Text Text

The selected border style can be applied by clicking the presets, preview diagram or the
above,

.

Top border
L~ selected and
previewed

Bottom border
selected and
previewed

SN~

FIGURE 3-10: Completed budget

Six-Month Budget

Six-Month Budget

July to December 2017

Your Name

e

JAN FEB MAR APR MAY JUN Totals Trend
Income
Salory $ 2,650.00 $ 2,650.00 $ 2,650.00 $ 265000 $ 2,65000 $ 265000 $ 15,900.00
Other Income 250.00 250.00 700.00 650.00 650.00 625.00 3,125.00
Total Income $ 2.900.00 $ 2,900.00 $ 3,350.00 $ 3,300.00 $ 3,300.00 $ 327500 $  19.025.00 IIII
Expenses
$ 1,100.00 $ 110000 $ 1,10000 $ 1,20000 $ 1,200.00 $ 1,200.00 ' $ 6,200.00
400.00 400.00 500.00 400.00 500.00 400.00 2,600.00
200.00 200.00 200.00 200.00 200.00 200.00 1,200.00
100.00 100.00 100.00 100.00 100.00 100.00 600.00
100.00 100.00 100.00 100.00 100.00 100.00 - 600.00
50.00 50.00 100.00
75.00 75.00 75.00 75.00 7500 75.00 450.00
100.00 - 100.00 100.00 100.00 100.00 . 100.00 - 600.00
50.00 50.00 50.00 50.00 50.00 5000 300.00
100.00 100.00 50.00 50.00 50.00 50.00 400.00
100.00 100.00 -100.00 100.00 100.00 100.00 600.00
200.00 200.00 200.00 200.00 200.00 200.00 1,200.00
300.00 400.00 300.00 300.00 300.00 300.00 1.900.00
Total Expenses 297500 $ 2.875.00 $ 2.875.00 $ 297500 $ 2,875.00 $ 17,450.00 I l

287500 $

2500 -$ 7500 % 47500 § 42500 % 32500 §

w000 s 1s7so0 - ANl
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Invoice Form and Tracker

Bloom Landscaping provides gardening and landscaping services to homes in Seattle, Washington. The
owner of the company has asked you to create a simple invoice form that she can use to bill her custom-
ers. She also wants you to create a worksheet that she can use to keep track of the invoices she sends out.
To create the invoice and invoice tracker, you Create the Invoice Form, Enter Invoice Information,
and Develop the Invoice Tracker. The completed invoice form is shown in FIGURE 3-13 and the
completed invoice tracker appears in FIGURE 3-17 on page 69.

Create the Invoice Form

You need to create an invoice form that includes labels for all the information the owner and customers
require, is easy to read and understand, and prints on one page.

H

1. Open a new workbook in Excel, apply the Parallax theme, type Bloom Landscaping in
cell A1 and INVOICE in cell H1, select the range A1:H1, fill the cells with Blue, Accent 1,
Darker 25%, change the font color to white, then with the cells still selected, increase
the font size to 24 pt and apply bold

2. Click cell H1, click the Align Right button = in the Alignment group, then save the
workbook as PR 3-Invoice Form and Tracker to the location where you save the files for
this book

3. Select column A, click the Format button in the Cells group, set the width of the column
at 18, set the column width of column H to 14, then enter and format the labels as
shown in FIGURE 3-11

4, Select cells B7:D9, click the Borders list arrow __ -, click Outside Borders, select the range

it

H6:H9, then click the Outside Borders button [

5. Click cell A11, type Quantity, press [Tab], type Unit, press [Tab], type Description, click
cell G11, type Unit Price, press [Tab], then type Amount

6. Select the range C11:F11, click the Merge & Center button in the Alignment group,
select the range A11:H11, apply bold and center alignment, then fill the cells with Blue,
Accent 1, Lighter 60%

7. Select the range C12:F12, click the Merge & Center button, click the lower-right corner
of cell F12, then drag = to cell F25

The cells under the Description heading are wider, allowing more room for the description.

8. Select the range A12:H25, click the Borders list arrow __ -, click All Borders, then
complete the bottom of the form so that it appears as shown in FIGURE 3-12

9. Click cell H2, click the Insert tab, click the Pictures button in the Illustrations group,
navigate to the location where you store Data files for this book, click PR 3-01.jpg, then
click Insert

10. Select the contents of the Height text box in the Size group, type .8, press [Enter], use
arrow keys to position the picture so that it fills the space below INVOICE as shown in
the completed invoice in FIGURE 3-13, then save the workbook
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FIGURE 3-11: Labels entered and enhanced
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9_[City, State)zip SALES TAX RATE 5.60% in cell H8 [ |
: X
& Apply bold to Right-align and bold '
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FIGURE 3-13: Picture positioned

Your Name

Bloom Landscaping

1600 Pacific Boulevard, Seattle, WA 98118

206-555-3377
www.bloomlandscapingseattie.com
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Invoice Form

INVOICE

SOLD TO: INVOICE NUMBER
City, State, Zip INVOICE DATE
Address TERMS Net 30
City, State, Zip SALES TAX RATE 9.60%
Q Y Unit Descrip Unit Price A
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$

$

$

s

s

s

3

$

s

s

s

s

s

SUBTOTAL| s

TAX| s

TOTAL| s

Thank you!




Excel 2016 = )
Invoice Form and Tracker (continued)

Enter Invoice Information

A useful form is one into which you only need to enter variable information such as the name of the client
and the various items they purchased. First, you enter formulas into the blank form and then you
complete the form for three different clients.

@ 1. Click cell H12, type =A12*G12, press [Enter], use the fill handle to copy the formula to

ggp\f:)l/izsiiriells cell H25, then click the Accounting Number Format button [$| in the Number group

H12:H25 because 2. Click cell H26, type =SUM(H12:H25), press [Enter], enter the formula =H26*H9 to
Zg;‘e'r’;fva”lztesyf; - calculate the sales tax based on the values in cells H26 and H9, press [Enter], enter the
cells associated with formula =H26+H27, then press [Enter]

(theformulss. ] 3, Select the range G12:G25, click the Accounting Number Format button '$], select the
range C12:C25, then click the Align Left button =]

4. Double-click the Sheet1 tab, type Invoice Form, press [Enter], click (), name the new
sheet 101, then add two more sheets named 102 and 103, respectively
You will keep one copy of the invoice form in the Invoice Form tab, and then create three new invoices—one
invoice per tab. By keeping all invoices together in one workbook, the owner of Bloom Landscaping simpli-
fies her billing procedures.

5. Click the Invoice Form tab, click the Select All button || at the top left corner of the
worksheet frame to select the entire worksheet, click the Copy button, click the 101 tab,
click the Paste button, click the 102 tab, click the Paste button, then paste the invoice
form in the 103 sheet

6. Go to the 101 sheet, complete invoice 101 as shown in FIGURE 3-14, verify that the total

Use the day-month- value in cell H28 is 52,192, then enter data in tab 102 and 103 according to the

year format (20- S .

May-27) for the following information:

dates and remember On May 30, 2017, Bloom Landscaping did 20 hours of consultation and landscape
1o enterthe correct design for Barry Lalonde of 34 Westview Road in Seattle (98120) and bought 15
cell H6 in each plants (assorted shrubs) at a cost of $25 each.

‘.:12:2:1%*}? On May 31, 2017, Bloom Landscaping did 5 hours of consultation and landscape
FIGURE 3-14 for design for Anne Leung of 100 Sunset Place in Seattle (98119) and 40 hours of site
hourly rates f : :

cg:;ﬁt;angi -’ - preparation and planting.

preparation. 7. Verify that the total in sheet 102 is $2,055.00 and the total in 103 is $2,603.00

—_—

8. Click &), name the new tab Tracker, press [Enter], drag the tab to the right of Invoice
Form, then set up the Tracker sheet so that it appears as shown in FIGURE 3-15

9. Click the Invoice Form tab, press and hold [Shift], click the 103 tab to select all five tabs
in the worksheet, click the File tab, click Print, click Page Setup, click the Header/Footer
tab, click Custom Header, enter your name in the Left section, click in the Right section,
click the Insert Sheet Name button & click OK, click OK, click the Back button &), then
save the workbook
By selecting multiple tabs, you group them into one worksheet so that you create the header for all five
worksheets at the same time.

HINT
Use the ScreenTips
to find the Insert
Sheet Name button.



FIGURE 3-14: Completed Invoice 101

Al R B PR DT TR e o TR TR H
6 |SOLDTO: INVOICE NUMBER 101
7 | Name Grant Martin INVOICE DATE 28-May-17
8“|Address 600 Tacoma Way TERMS Net 30
g |City, State, Zip Seattle, WA 98112 SALES TAX RATE] 9.60% \
20 | o - I v RIS Use dd-mm-yy
11 Quantity Unit : _ Description _UnitPrice  Amount format for date
12 12|Hours Consultation and landscape design $ 7500 |$ g00.00
13 20|Plants Ground covers $ ©500|$ 100.00
14 20|Hours Site preparation and planting $ 5000 |$ 1,000.00
15 $ R
16 $ &
17 $ d
18 $ =
13 $ <
20 $ =
21 $ -
22 s :
23 s -
24 $ -
25 $ -
26 SUBTOTAL| s 2,000.00
27 | TAX| s 192.00
28 | TOTAL| s 2,192.00
Invoice Form | 101 | 102 I 103 ! ®

FIGURE 3-15: Labels for the Invoice Tracker

4 A 8 1 C , D i E [ F G , H | I O i L
1 | Invoice Tracker

2

3 |invoice#  Date DueDate Customer Name Amount  lateFee  TotalPaid  DatePaid  Outstanding

4 101 [ L J \
s ]

6. Bold the headings
-~ in row 3

&

10| Bold and 24 pt The column width of all columns

:L except Column D is set at 12.

= Column D width is set at 25.

14| ‘

15|

16
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Excel 2016 . "
Module 3 Invoice Form and Tracker (continued)

. Develop the Invoice Tracker

You can use Excel to automate many common business tasks, including keeping track of invoices in one
easy-to-read list. You format the Invoice Tracker as a table that will list information about each of the three
invoices you have created and then enter invoice data from the three Invoice tabs. The completed Invoice
Tracker is shown in FIGURE 3-17.

1. In the Tracker worksheet, select the range A3:120, click Format as Table in the Styles
group, select Table Style Medium 2 (blue), click the My table has headers check box to
select it, if necessary, click OK, click the Banded Rows check box in the Table Style
Options group to deselect it, click Convert to Range in the Tools group, then click Yes
You've formatted the Invoice Tracker as a table so that you can quickly apply border lines and shading. You
then converted the table to a range so that you can turn off the calculated columns feature. When you are
entering cell references from other sheets into a table with the calculated columns feature active, you can
get unexpected results when you copy formulas.

2. Click cell AS, type 102, select cells A4 and AS, then drag the fill handle from cell A5 to
cell A20 to fill all the cells with invoice numbers in sequential order
You set up the sequence by entering 101 and then 102. If you copied only 101, you would fill the column
with 101, rather than with the sequential numbers: 101, 102, 103, and so on.

3. Enter the values from invoice 101 in the tracker as follows: click cell B4, type =, click the
101 tab, click cell H7, press [Enter], click cell C4, type = B4+30, press [Enter], click cell D4,
type =, click the 101 tab, click cell B7, press [Enter], click cell E4, type =, click the 101 tab,
click cell H28 to select the invoice total, press [Enter], then enter 2000 in cell G4 and
30-Jun-17 in cell H4

4. Select the range F4:G20, press and hold the [CTRL] key, select the range 14:120, then
apply the Accounting Number style
Now you are ready to enter formulas to calculate the late fee and outstanding balance.

5. Click cell F4, click the Insert Function button 7 on the formula bar, click IF, click OK,
type H4>C4, press [Tab], type 5, press [Tab], type 0, then compare the Function
Arguments dialog box to FIGURE 3-16
The IF function enters $5.00 in cell F4 (Late Fee) IF the date in cell H4 (Date Paid) is later than the date in
cell C4 (Payment Date).

6. Click OK, click cell 14, type =E4-G4+F4, then press [Enter]

7. Click cell B5, enter the cell address for the invoice date from invoice 102, use the Format
Painter to apply the correct date format if necessary, enter the cell address for the customer
name in cell D5, enter the total invoice amount from invoice 102 in cell E5, click cell G5,
type =ES to enter the amount paid, then type 25-June-17 for the Date Paid

8. Repeat Step 7 for invoice 103, but this time enter the Total Paid as 1500 and the Date

TROUBLE
Apply the correct
date format as

necessary.

TROUBLE
Be sure to type 0

(zero) for the False
value.

TROUBLE
You will use AutoFill
to enter the remain-
ing data in a

later step.

Paid as 13-Jul-17, then fill cells with the formulas from row 4 so that each invoice

| For more piactce includes a Due Date, a Late Fee (if applicable), and an Outstanding Balance

ipfe§€“ted inthis @ 9, On Invoice 102, change the name to Bart Lalonde and the consultation hours to 25, return

ﬂrg’e;fgéznmtp'ete ) to the Tracker, compare it to FIGURE 3-17, set it up to print in Landscape orientation and to

Challenge2. | fit on one page, submit copies of all five worksheets to your instructor, then save and close
—————— the workbook
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FIGURE 3-16: Function Arguments dialog hox

Function Arguments

IF

. Logical_test | H4>C4

= TRUE

Value_if_true |5

Formula result = 5

Value_if_false ‘B '

=5
=0

=5

Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE.

Value_if_faise is the value that is returned if Logical_test is FALSE. If omitted, FALSE

is returned.

Help on this function I oK l | Cancel |
FIGURE 3-17: Completed and updated Invoice Tracker
Your Name Tracker
Invoice Tracker
Invoice # Date Due Date Customer Name Amount Late Fee Total Paid Date Paid Oustanding
_301  28-May-17  27-Jun-a7 GrantMartn $ 239200 § 500 § 200000  30-Jun-17 s 197.00
102 30-May-17  29-Jun-17 Bart L{alqr)d‘e_” ) i S 246600 s - s 2,466.00 25-Jun-17 s -
203 31-May-17 30-Jun-17 Anneleung s 260300 s 500 S 1,500.00 _23-Jul-z s 1,208.00
104 ”
105




Loan Amortization Schedule

Borrowing money usually costs money because you generally need to pay interest on the money that you
borrow. One of the most useful ways in which you can use Excel is to help you determine the cost of a loan,
including payments, interest, and the total cost of borrowing. For example, you can set up a loan amortiza-
tion schedule to calculate the cost of a car loan or a student loan or a mortgage on a house. You use func-
tions such as PMT to set up an amortization schedule that includes a table detailing all the payments
involved in the loan. For this project you need to Set up the Schedule and then Enter Formulas to
Calculate Payments. The completed loan amortization schedule is shown in FIGURE 3-22 on page 73.

Set Up the Schedule

1. Create a blank workbook in Excel, select the Retrospect theme, then save the workbook
as PR 3-Loan Amortization Schedule

Select columns A to |, then set the column width to 12

Enter and format labels for the worksheet as shown in FiGure 3-18, selecting the color
indicated in the figure for the shaded areas

4. Select the range B4:B8, click the Increase Indent button 3= in the Alignment group
two times, then increase the indent two times for the range F4:F5

5. Click cell A10, enter just the labels shown in FiGuRE 3-19 (your labels will not yet wrap,
be bold, or be formatted as a table)

6. Select the range A10:122, click Format as Table in the Styles group, select Table Style
Light 3, click the My table has headers check box to select it, then click OK

7. Select columns A to |, reset the column width to 12, select the range A10:110, then
click Wrap Text in the Alignment group on the Home tab
When you format cells as a table, the column widths are sometimes adjusted and you need to readjust
them. By default, filter arrows appear in the header row of a table so that you can filter table entries. You
can remove these arrows.

8. With row 1 of the table still selected, click the Table Tools Design tab, click the Filter
Button check box in the Table Style Options group to deselect it, then click away from
the table
The formatted table appears as shown in FIGURE 3-19.

9. Click cell D4, enter and format values related to a loan for $10,000 and rename the
sheet tab Loan Schedule as shown in FIGURE 3-20, then save the workbook
To calculate loan payments you need the loan amount ($10,000), the interest rate being charged (4%), and
the number of years over which you plan to pay off the loan (1). You also enter an optional extra monthly
payment of $100. In the next lesson, you can enter these values into the PMT function to determine your
monthly payment.
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FIGURE 3-18: Labels for cells A1 to I8

AfEiER T B J c : |

E i

Loan Amortization Schedul

[

|

Loan information
Loan amount
Annual interest rate

{

i

UéthN

e

F i
Format the title
with 24 pt and bold

G

Loan Summary

Scheduled payment
Total inM

-

Loan period in years

D m——

w:m‘

Optional extra payments

W

]

Add outside
border lines

Shading color — Orange,
Accent 2, Lighter 80%

FIGURE 3-19: Labels for row 10

9

Scheduled  Extra
Payment Payment

Beginning ’ Total

Balance

Payment

10 |PMT No Date

Payment

Interest

Ending

Principal Balance

FIGURE 3-20: Formatted table and loan information

-~
& cat Calibri BT AR 5 Wrap Text Accounting [F‘,‘H
ER Copy - =
& roavions | B T M E b AR TE EMergeBiCenter ~+ $ - % 1+ 8 9 ;‘:\‘;::_’: F:’ﬂ’::
Ciipboard Font & Alignment Number & Styles
o] 4 f 100
4 A i 8 C e o E F G H 1 ]
‘ . -
1 Loan Amortization Schedule
{
21
3 | Loan Information Loan Summary
4 | Loan amount $ 10,000.00 Scheduled payment
5| Annual interest rate a% Total interest
6 Lozn period in years 1
7.
8 Optional extra payments| $ 100.00
L =
| Payment Beginning Scheduled  Extra Total Ending
10/PMTNo  Date Balance Payment _ Payment Payment Interest Principal __ Balance
n
12]
13
14
135
L
7]
18]
19
20]
=
|_Loan Schedule (O] T
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Loan Amortization Schedule (continued)

Enter Formulas to Calculate Payments

You use the PMT function to calculate loan payments and then you can enter payments in the table. Once
you have entered the required values for the PMT function and the function itself, you can use the Loan
Amortization Schedule as a template for a wide range of loans, adding rows as needed. The completed
schedule is shown in FIGURE 3-22.

TROUBLE
After exiting
the Function
Arguments dialog
box, you should see
$851.50. If you do
not, click the Insert
Function button
to return to the
dialog box and
compare it closely
to FIGURE 3-21.

-

MORE PRACTICE
For more practice |
with the skills i

presented in this |
project, complete é
Independent |

|

Challenge 2.

1. Click cell H4, click the Insert Function button % on the Formula bar, type PMT, press
[Enter], click OK, type $D$5/12 in the Rate text box

You will be copying the PMT function, so you need to make the values required for the function absolute.
You divide the interest rate by 12 to determine the monthly interest rate.

2. Click in the Nper box, type $D$6*12, click in the PV box, enter -$D$4, then compare
the Function Arguments dialog box to FIGURE 3-21
You multiply the loan period by 12 to determine the number of months you will be paying off the loan.
The PV is the loan amount. You made this value a negative value because it is money owed.

3. Click OK, click cell A11, type 1, type 2 in cell A12, select cells A11 and A12, fill the remaining
rows in the table (to cell A22) with sequential numbers, click cell B11, type January 1, 2017,
press [Enter], type February 1, 2017 in cell B12, then select cells B11 and B12 and fill the
remaining rows in the table with the dates from March 1, 2017 to December 1, 2017
When you enter a date, Excel formats is as Day-Month-Year; for example, 01-Jan-17.

4. Click cell C11, type =D4 to enter the beginning balance ($10,000), press [Enter], ignore
the additional entries, click cell D11, type =$H$4, press [Enter], click cell E11, type
=$D$8, then press [Enter]

5. Incell F11, enter the formula =D11+E11 to add the Scheduled Payment to the Extra
payment, in cell G11, enter the formula =C11*(SD$5/12), then in cell H11, enter the
formula =F11-G11 to subtract the Interest from the Total Payment

6. In cell 111, enter the formula =C11-F11 (the Total Payment subtracted from the
Beginning Balance), click cell C12, type =111, click the Undo button ] to remove the
error messages, drag the Fill handle for cell C12 to cell C22, format the values in
columns E and G with the Accounting Number format, then click below the table
The Amortization table appears as shown in FIGURE 3-22.

7. Click cell D4, type 5000, press [Enter], change the interest rate to 2%, then delete the
optional extra payment in cell D8
Notice how the scheduled payment is now $421.19 and the values in the table have updated.

8. Click cell HS, type =SUM(, select the range G11:G22, type a closed parenthesis ), press
[Enter], then format the value with the Accounting Number format

9. Click the File tab, click Print, click Page Setup, select Landscape orientation, center the
worksheet horizontally (using the Margins tab in the Page Setup dialog box), then
create a custom header showing your name in the left corner and using the Insert Sheet
Name button in the Header dialog box to insert the sheet name in the right corner as
shown in the completed worksheet in FiGURE 3-23, save the workbook and submit a copy
to your instructor, then close the workbook
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FIGURE 3-21: Data for the PMT function

=
Function Arguments ? X
| PMT
‘ Rate (505572 = 0003333333
Nper spseri2 -2
’ ; Pv [sDsd = 10000
| o = number
Type = number
| = 851499042
| Caiculates the payment for a loan based on constant payments and a constant interest rate,
| Pv is the present value: the total amount that a series of future payments
Is worth now.
| Formuta resuit = 851.499042
| G
| Helo on this tunction E i Cancet |
L
FIGURE 3-22: Completed Loan Amortization Schedule
4 ey B C i D E i F G i H | J K
T
{ - -
1 |Loan Amortization Schedule
z]
3? Loan information Loan Summary E
4] Loan amount $ 10,000.00 Scheduled payment $851.50|
5 ! Annual interest rate 4% Tota! interest
64’ Loan period in years 1
T
8 ] Optional extra payments §  100.00
9
Payment Beginning Scheduled Extra Total Ending
10 {PMT No Date Balance Payment Payment Payment Interest Principal Balance
1]‘ 1 01-jan-17 $ 10,000.00 $85150 $ 100.00 $95150 $ 3333 $918.17 § 9,04850
12_ 2 01-Feb-17"$  9,048.50 $85150 § 100.00 $95150 S 30.16 $921.34 § 3,097.00
1}_ 3 Oi-Mar-17 ’S 8,097.00 $85150 § 100.00 $951.50 § 2699 $92451 § 714550
114 4 o1-Apr-17”s 7,145.50 $851.50 § 100.00 $95150 § 2382 $927.68 S 6,194.00
1—5—« 5 01<MBV-17'$ 6,194.00 $85150 § 100.00 $95150 § 2085 $93085 § 524250
16 6 01-un-17"$ 5,242.50 $851.50 S 100.00 $951.50 S 17.48 $93402 $ 4,291.01
17 7 01-Jui-17 'S 4,291.01 $85150 § 10000 $95150 § 1430 $937.20 § 3,339.51
18__‘ 8 01-Au2-17'5 3,339.51 $85150 S 100.00 $951.50 $ 11.13 $940.37 § 2,388.01
19 & 01-5ep-17'$ 2,388.01 $85150 § 100.00 $951.50 § 796 $943.54 § 143651
20 10 01-0ct-17 '5 1,436.51 $851.50 § 100.00 $951.50 § 4.79 $946.71 S 48501 :
Z'I4 11 01-M17'$ 485.01 $85150 S 100.00 $951.50 $ 182 $94988 -5  466.49 Your negatlve numbers may
2 12 01-Dec-17"5  a66.43 $85150 5 10000 $951.50 -5 155 $95305 5 1,417.99, appear in parentheses.
_:?-91 1 |
« v | Losnschedule | @ ]
FIGURE 3-23: Revised Loan Amortization Schedule
Your Name Loan Schedule
Loan Amortization Schedule
Loan information Loan Summary
Loan amount $  5,000.00 Scheduled payment
Annual interest rate 2% Total interest
Loan period in years 1
Optional extra payments
Beginning Scheduled Ending
PMT No Payment Date Balance Payment Extra Payment Total Payment Interest Principal Balance
1 0l-Jan-17 $  5,000.00 $421.19 § - $421.13 $ 833 $41286 $ 4,578.81
2 Ol-Feb-17 § 4,578.81 $421.19 § - $421.19 $ 7.63 $41356 S 4,157.61
;| 01-Mar-17' §  4,157.61 $421.19 § $421.19 $ 6.93 $41426 §  3,736.42
4 01-Apr17 $§  3,736.42 $421.19 § = $421.13 S 6.23 $414.97 $ 331522
5 01-May-17 § 331522 $421.19 § . 542119 § 553 $41567 $  2,894.03
6 01-jun-17 §  2,894.03 $421.19 § e $42118 $ 482 541637 5 247283
7 01-juk17 § 247283 $421.19 § $421.19 § 4.12 $417.07 § 205164
8 01-Aug-17 $  2,051.64 $421.19 § . $421.19 S 3.42 $417.77 $  1,630.45
e 01-5ep-17 §  1,630.45 $421.19 § - $421.19 § 272 $41848 S 1,209.25
10 01-Oct-17 §  1,209.25 $421.19 § - $421.19 S 2.02 $419.18 $ 788.06
1 01-Nov-17 $§ 788.06 $421.19 § - $42113 § 131 $419.88 5 366.86
12 01-Dec-17 $ 366.86 $421.19 § ‘ $421.18 S 0.61 $420.58 -$ 54.33




Sales Report for Gourmet Style

As an analyst for Gourmet Style, a small catering company, you use an existing product list to produce a
report that analyzes sales over three years. The report includes two worksheets—one with conditional
formatting that provides a visual comparison of product sales, and the other with a PivotTable and column
chart that arrange and summarize product data to allow for comparisons and trend analysis. To create the
Sales Report, you need to Apply Conditional Formatting and Filter and Chart Results.

Apply Conditional Formatting

You open the product list, use conditional formatting to highlight trends, then create a PivotTable that
shows yearly sales by product category.

1. Start Excel, open PR 4-03.xIsx from the location where you store your Data Files, save it
as PR 4-Gourmet Style Sales Analysis to the location where you save the files for this
book, then apply the Basis theme

2. Click cell F1, type Total, use the SUM function in cell F2 to calculate the total number of
products sold in all three years, then use the Fill handle to copy the formula for all products
The worksheet contains the total menu items that Gourmet Style sold in its catering business in each year
from 2015 to 2017. Each product is assigned to a category such as “Appetizer” or “Dessert.”

3. Select cells A1:F1, click the Home tab, click the Cell Styles button in the Styles group,
click Accent2 in the Themed Cell Styles section, then bold and center the headings

" 4. Select the range F2:F30, click the Conditional Formatting button in the Styles group,
:g:’n;’;&gg’;g’ﬂ?g“f point to Data Bars, click Blue Data Bar in the Solid Fill area, increase the width of the
light cells containing Total column to 15, then click cell G1

text based on The Conditional Formatting shows that Papaya Salad is the most popular product as shown in FIGURE 4-18.

e 5. Select the range B2:B30, click the Conditional Formatting button, point to Highlight
Cells Rules, click Text that Contains, notice that Salad is selected, then click OK
All instances of “Salad” in the range are formatted with a red font color and light red fill.
6. Click the Conditional Formatting button again, point to Highlight Cells Rules, click
Text that Contains, type Dessert, click the with list arrow, click Custom Format,
click the Fill tab, click the second lightest Blue color box, click OK, then click OK

7. Repeat Step 6 to format Main Course with a light green fill and Appetizer with a
light orange fill, then click cell A1

8. Name Sheet1 Sales Data, add a new sheet called Product Sales, select A1:F30 in the Sales
Data sheet, click the Insert tab, click PivotTable in the Tables group, click the Existing
Worksheet option button, click the Product Sales sheet tab, click cell A1, then click OK
The PivotTable Tools Analyze and Design tabs are now available and the PivotTable Fields pane opens on
the right side of the window.

9. In the Product Sales sheet, click the Product check box in the PivotTable Fields pane,
click each of the remaining check boxes in the PivotTable Fields pane as shown in
FIGURE 4-19, then save the workbook
All the data from the list is added to the PivotTable, with each product assigned to a different row.

All the products are
added to the
PivotTable in alpha-
betical order starting
in cell A2 with
“Apricot Cobbler.”
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FIGURE 4-18: Data bars applied to the Total column
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FIGURE 4-19: PivotTable in the Product Sales sheet
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Sales Report (continued)

Filter and Chart Results

You modify the PivotTable, then create a PivotChart. The completed sales report is shown in FIGURE 4-21.

Bl srees B

presented in this
project, complete
Independent

Challenge 3.

|
|

1

Z.

MORE PRACTICE 8.
For more practice
with the skills !

Click Product in the ROWS area of the PivotTable Fields pane, click Move Down to sort
and summarize the products by category, insert a new row above row 1 in the
PivotTable and type Gourmet Style Sales Report, press [Enter], apply the Title style to
cell A1, then click in the PivotTable to show the PivotTable Fields pane

Click the Collapse button [-]to the left of Appetizer to collapse the list of appetizers,
then click | - | next to Dessert, Main Course, and Salad so all four categories are
collapsed as shown in FIGURE 4-20

. Click the Insert tab, click the Insert Column or Bar Chart button [ 1] in the Charts

group, click Clustered Column, then drag the chart to position its upper-left corner in
cell AT0 ’

Deselect the 2016 check box and the Total check box in the PivotTable Fields pane

Only data for 2015 and 2017 is shown. As you can see, Gourmet Style experienced a significant reduction
in sales of all four product categories between 2015 and 2017.

. Click the Sales Data sheet tab, click cell E4, type 400, press [Enter], then notice how the

width of the blue bar in cell F4 increases

Click the Product Sales sheet tab, click the PivotChart Tools Analyze tab, then click the
Refresh button in the Data group

The total items for 2017 are now 6690 and the height of the red bar for Salad sales in 2017 has increased.
Each time you change the data used to build the PivotTable, you need to refresh the PivotTable.

Click the chart, click the PivotChart Tools Analyze tab, if necessary, click the Field
Buttons list arrow in the Show/Hide group, then click Hide All

Show the Sales Data worksheet, press and hold [Shift], click the Product Sales sheet,
set up both worksheets to print on one page each, centered horizontally, with your
name in the Left section of the Header and the sheet name in the Right section,
submit the workbook to your instructor, then close the workbook

The completed Sales Data and Product Sales worksheets appear as shown in FIGURE 4-21.
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FIGURE 4-20: Groups collapsed
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®MainCourse 3630 3270 2120 9020 | . o
@ Salad 3715 3300 2190 9205
| 7.|Grand Total 11175 10070 6320 27565 |

~ Data from Sales Data worksheet
tab used to create report on
Products Sales worksheet tab
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FIGURE 4-21: Product Sales and Sales Data

Your Name Sales Data

Pineapple Slaw
Mango Custard
Blueberry Salad
Toasted Almond Salad
Saimon with Lemon
Lime Scallops

Roast Chicken

Kiwi Cream

Baked Yams with Feta
Tuna Sashimi

Papaya Salad
Asparagus Salad
Raspberry Tart

Sweet Onion Pie
Stilton Salad

Apricot Cobbler
Maple Saimon
Hazeinut Salad
Braised Lamb Shanks
Green Olive Tapenade
Smoked Salmen Wrap
Mahi Mahi

Artichoke Salad
Roast Beef

Crunchy Kale Salad
Pork with Blackberries
Leek Fritters

Quince in Aspic
Mushroom Casseroie

m
x
(x
@
N
(=]
—
D

Your Name Product Sales

Gourmet Style Sales Report

Rowlabels _Sum of 2045 Sum of 2017
Appetizer 1910 1010
Dessert 1930 1000
Main Course 3630 2120
Salad 375 2560

Grand Total 31175 6690
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